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Topic 1, Volume A

QUESTION NO: 1 

A customer has an escalation that requires notifications to go to both Marie Smith and her
supervisor Lee Tsumi. How can both users be included as recipients on a communication
template?

A. Create a role for both Marie and Lee 
B. Create a Person Group with Marie as the primary 
C. Add both e-mail addresses on the Recipients tab 
D. Include both user e-mails in the Recipient field separated by a colon 

Answer: C

  

QUESTION NO: 2 

Which IBM Maximo Asset Management location status is necessary to associate a location with a
system?

A. Active 
B. Ready 
C. Operating 
D. Decommissioned 

Answer: C

  

QUESTION NO: 3 

An asset is created and measurement points are associated. Which IBM Maximo Asset
Management V7.5 application sets Upper Limit and Lower Limit Job Plans?

A. Meters 
B. Assets 
C. Condition Monitoring 
D. Work Order Tracking 

Answer: C
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QUESTION NO: 4 

What does the Enable Repair Facilities Organization option allow?

A. Creating a work order in a site different from the site of the asset on that work order 
B. Reserving items from one site to use at another site on an emergency maintenance work order 
C. Moving an asset from one location to another location on an emergency maintenance work
order 
D. Creating a preventive maintenance (PM) record in a site different from the site of the asset on
that PM 

Answer: A

  

QUESTION NO: 5 

Which property is used to define the directory used when importing data using the Integration
Framework?

A. Mxe.int.dir 
B. Mxe.int.localdir 
C. Mxe.int.globaldir 
D. Mxe.int.accessdir 

Answer: C

  

QUESTION NO: 6 

After fully receiving a shipment it is discovered that the item or tool has been received incorrectly.
How can a receipt be reversed from the Shipment Receiving application?

A. Find the shipment receipt, change the status to VOID from the Select Action menu, click Save 
B. Find the shipment receipt, click the checkbox Void Receipt for each line to be reversed, click
Save 
C. Find the shipment receipt, click the button Select Receipt to Void, select each line to be voided,
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click OK 
D. Find the shipment receipt, click the button Select Records to Void, select each line to be
voided, click OK 

Answer: D

  

QUESTION NO: 7 

What is the purpose of commodity codes?

A. To group like items for issue 
B. To group like items for purchasing 
C. To group like items for classification 
D. To group like items for asset bill of material 

Answer: B

  

QUESTION NO: 8 

What are two uses for the Assignment Manager application? (Choose two.)

A. To dispatch labor and schedule work for an organization 
B. To create and manage work orders for assets and locations 
C. To report labor transactions by labor, by vendor/contract, by work order, or by ticket 
D. To specify which organizations and sites can use the information that is on the job plan and its
tasks 
E. To view the requirements that were created from the work plan as well as the unplanned work
on a work order 

Answer: A,E

  

QUESTION NO: 9 

What comprises a failure code?
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A. Failure, affect, fix 
B. Issue, reason, resolution 
C. Problem, cause, remedy 
D. Situation, impact, solution 

Answer: C

Failure codes are specified on asset records and on location records. Failure codes

are linked in parent-child relationships to form a failure hierarchy. 

QUESTION NO: 10 

What does an active workflow process define?

A. The flow of work in Application Designer 
B. The process to add an attribute to an application 
C. The different work to be performed by the lead craft 
D. The different paths that a record can take as it moves through a business process 

Answer: D

You use the Workflow Designer application to create, to view, to modify, and to

delete workflow process records that reflect your business processes.  

An active workflow process defines the different paths that a record can take as it moves through

a business process. The workflow process also specifies the actions and notifications that can

take place at different points in a process. 

QUESTION NO: 11 

When creating a purchase request line by using the Select Spare Parts button, refined search is
allowed by specifying at least one of which two data fields? (Choose two.)

A. Site ID 
B. Description 
C. Item Number 
D. Asset Number 
E. Organization ID 
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Answer: A,D

  

QUESTION NO: 12 

Which standard relationship is the container relationship for assets?

A. BACKUPS 
B. INCLUDES 
C. CONNECTS  
D. INTERSECTS 

Answer: B

  

QUESTION NO: 13 

Which method is used to view labor hours, costs, and material costs for a particular work order?

A. from the Work Order Tracking application, select the Cost tab 
B. from the Work Order Tracking application, go to the Select Action menu and select View >
Costs 
C. from the Actuals tab of Work Order Tracking application, download and summarize each of the
table windows for Labor, Materials. Services, and Tools 
D. navigate to the Cost Management application, query for the work order in question to view
estimated and actual hours and costs for labor in addition to estimated and actual costs for
materials and service 

Answer: B

  

QUESTION NO: 14 

Which statement is true to review the content of a scheduled report?

A. Use the Report Administration application to view and select from a list of report outputs 
B. Use the Report Administration application to choose the correct report and then click the View
button 
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C. Use the URL from the link supplied in the e-mail to access a PDF file served up directly by the
HTTP server 
D. Access the URL from the link supplied in the e-mail and then log into Maximo and select the
Download Content button 

Answer: D

  

QUESTION NO: 15 

In the Receiving application, what does the Quantity Accepted field indicate?

A. The quantity of items that passed inspection 
B. The quantity of items accepted for inspection 
C. The quantity of items that received inspection 
D. The quantity of items that are awaiting inspection 

Answer: A

  

QUESTION NO: 16 

If the Integrity Checker utility tool reports that some groups have no privileges in the Maximo
security tables, how could this be resolved?

A. Run the integrity checker in repair mode 
B. Run the integrity checker in backup mode 
C. Create a new Maximo Security group for the Maximo security tables and run the Integrity
Checker utility again 
D. Create a new security group with all grants on the Maximo security tables and run the Integrity
Checker utility again 

Answer: A

  

QUESTION NO: 17 

A forecast for a preventive maintenance record has been generated. How can the forecast date be
adjusted from the Preventive Maintenance application?
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A. From the Forecast tab, select a forecast row, enter a value in the New Date field, click Save 
B. From the Select Action menu, select Generate Forecast, enter a value in the Forecast Days
field, click OK 
C. From the Frequency tab, select the Time Based Frequency tab, enter a value in the Frequency
field, click Save 
D. From the Frequency tab, select the Time Based Frequency tab, enter a value in the Extended
Date field, click Save 

Answer: A

  

QUESTION NO: 18 

What is the definition of a work package?

A. It groups existing work orders under a new parent work order. 
B. It is a preventive maintenance work order hierarchy that has been created from a route. 
C. It is a work order linked to all the originating services requests for the work order and is created
from the Related Records tab. 
D. It is a group of work orders in Waiting to be Scheduled status that are the responsibility of one
person and is created in the Assignment Manager application. 

Answer: A

  

QUESTION NO: 19 

A company has deployed IBM Maximo Asset Management V7.5 (Maximo) to manage the
company assets and the purchasing process. The company's purchasing process does not require
an approved purchase request (PR) in order to generate a new purchase order (PO) but the buyer
reported this problem when trying to create a new PO from an unapproved PR: 
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Where can this validation be turned off in Maximo?

A. Organizations application 
B. Purchase Orders application 
C. System Properties application 
D. Database Configuration application 

Answer: A

  

QUESTION NO: 20 

Which function is performed in the Quick Reporting application?

A. Create failure code hierarchies 
B. Create job plans and safety plans 
C. Create preventive maintenance schedules 
D. Report actual labor, materials, and tools used in the work 

Answer: D

  

QUESTION NO: 21 

Which two items must be created before an organization can be active? (Choose two.)

A. Site 
B. Item Set 
C. Currency Code 
D. Primary Vendor 
E. Financial Period 

Answer: B,C

  

QUESTION NO: 22 

A reservation is created when a work order is approved with item(s) on the Work Order Plans
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Materials sub-tab. Which action controls when an item must be specified with a hard reservation?

A. Change the reservation type on the materials line to HARD 
B. Change the reservation type on the reservation list to HARD 
C. Set the reservation type to HARD within the Organization > Inventory Options 
D. Set the flag on this check box within the Inventory application: Requires hard reservation on
use? 

Answer: D

  

QUESTION NO: 23 

Which statement applies to relationships?

A. They can use locations. 
B. They can be used with locations. 
C. They can be defined as bidirectional. 
D. They can be defined as non-directional. 

Answer: C

  

QUESTION NO: 24 

Which three data elements on the Plans tab of the Work Order Tracking application can be
restricted from editing or adding new values based on the work order's status (Organization >
Work Order Options > Edit Rules)? (Choose three)

A. Creating or editing planned tools 
B. Creating or editing planned tasks 
C. Adding or changing the failure class 
D. Creating or editing planned materials 
E. Creating or editing planned labor entries 
F. Creating or associating a child work order 

Answer: A,D,E
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QUESTION NO: 25 

How is the order determined in which tax codes are used?

A. Tax code options from the Tax application 
B. Tax options from the Organizations application 
C. Tax options from the Purchase Orders application 
D. Tax code options from the Chart of Account application 

Answer: B

  

QUESTION NO: 26 

Which statement is true related to job plan revisions?

A. A job plan must be in a status of DRAFT or PNDREV for updates and edits to the job plan tab. 
B. When a job plan is revised, all existing work orders with the job plan attached are updated with
the revised version. 
C. Caution must be used to select the most recent job plan revision when applying a job plan to a
work order or preventive maintenance record. 
D. When a job plan has been revised, IBM Maximo Asset Management V7.5 tracks all changes
from previous versions. These changes are available for viewing from Select Action > View
Revision History. 

Answer: A

  

QUESTION NO: 27 

What can be defined on a work order?

A. Name 
B. Location 
C. Security Group 
D. Report Template 

Answer: B
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QUESTION NO: 28 

Which contract type defines the agreement to maintain one or more assets with an outside service
provider for a fee or a scheduled set of payments?

A. Service Contract 
B. Warranty Contract 
C. Purchase Contract 
D. Labor Rate Contract 

Answer: B

  

QUESTION NO: 29 

Which option attaches an image to an item master record in the Item Master application?

A. Clicking on the Image icon 
B. Clicking on the Attachments icon 
C. Select Action > Add/Modify Image 
D. Select Action > Attachment/Library Folders 

Answer: C

  

QUESTION NO: 30 

When a work order is created from a preventive maintenance record that references a route, the
route stops will become child work orders with a common job plan. From which record will the
resulting parent work order description be created?

A. It will be the same as the route description. 
B. It will be the same as the job plan description. 
C. It will be null, to be updated with a description specific to the job. 
D. It will be the same as the preventive maintenance record description. 

Answer: D
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QUESTION NO: 31 

What is the standard default status of a purchase order when it is created in IBM Maximo Asset
Management V7.5?

A. New 
B. Created 
C. In Progress 
D. Waiting on Approval 

Answer: D

  

QUESTION NO: 32 

Which type of role is defined as: You use this data type to route a record based on information in a
person record?

A. USER 
B. PERSON 
C. USERDATA 
D. PERSONGROUP 

Answer: B

  

QUESTION NO: 33 

What are three components used to build an IBM Maximo Asset Management V7.5 safety plan?
(Choose three.)

A. Routes 
B. Assets 
C. Hazards 
D. Tag Outs 
E. PM Records 
F. Condition Monitoring Points 
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Answer: B,C,D

  

QUESTION NO: 34 

What is required to create an escalation?

A. Site 
B. Schedule 
C. Condition 
D. Description 

Answer: B

  

QUESTION NO: 35 

When defining new reports in the various IBM Maximo Asset Management applications, which
statement is true about browser shortcuts created for those reports?

A. Shortcuts can be created as hyperlinks 
B. Shortcuts can be created for any report 
C. Shortcuts can be created in the Application Designer 
D. Shortcuts can be created for a report that has no parameters 

Answer: D

  

QUESTION NO: 36 

What are two ways an administrator can add an existing attribute to the Work Order Tracking
application? (Choose two.)

A. Conditional Ul application > select WOTRACK, select the new attribute, click the Show button 
B. Database Configuration application > select WORKORDER object, select the new attribute,
click the Show button 
C. Application Designer application > under Select Action menu select the Add/Modify Attributes
option, add the new attribute to the canvas 
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D. Application Designer application > select WOTRACK, drag and drop the appropriate control to
the canvas, configure the control properties to bind the new attribute 
E. Application Designer application > select WOTRACK application, export the presentation XML
file, make appropriate changes in the XML file, import the presentation XML file 

Answer: D,E

  

QUESTION NO: 37 

What is the purpose of Stock Categories in IBM Maximo Asset Management V7.5?

A. To define whether an item can be placed in inventory 
B. To define whether an item can be automatically reordered 
C. To designate whether an item will be automatically reordered 
D. To designate the difference between stocked and special order items 

Answer: A

  

QUESTION NO: 38 

Which domain types can be added?

A. Synonym, Internal, ALN 
B. Numeric, Crossover, Table 
C. ALN, Crossover, Synonym 
D. Synonym, Table, Crossover 

Answer: B

  

QUESTION NO: 39 

A customer has a requirement to automatically create a work order from a service request when
the customer service manager approves the request using Workflow. Which object does this
action apply to?
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A. SR 
B. Ticket 
C. Workflow 
D. Workorder 

Answer: A

  

QUESTION NO: 40 

A work order is generated from a route and each stop on the route has a unique job plan and
safety plan. Which option should be selected for: When this Route is Applied to a Work Order, the
Route Stops will Become?

A. Child Work Orders  
B. Work Order Tasks  
C. Sequenced Job Plans 
D. Entries in the Work Order's Multi Asset, Location, and CI Table 

Answer: A

  

QUESTION NO: 41 

When adding an item to a storeroom, which two fields must be entered? (Choose two.)

A. Unit Cost 
B. Issue Unit 
C. Order Unit 
D. Current Balance 
E. Issue Cost Type 

Answer: B,E

  

QUESTION NO: 42 

Where are IBM Maximo Asset Management V7.5 properties changed?

16



A. Logging.properties file 
B. Mxserver.properties file 
C. System Properties application 
D. Application Properties application 

Answer: C

  

QUESTION NO: 43 

Which structure can be applied when creating a rotating asset record?

A. Material structures 
B. Child Asset structures 
C. Asset Details structures 
D. Item Assembly structures  

Answer: D

  

QUESTION NO: 44 

Which statement is true regarding the master Preventive Maintenance (PM) record?

A. A master PM record is generated by the Meters application. 
B. A master PM record is generated by the Assets application. 
C. A master PM record generates work orders like any other PM. 
D. Associations between existing PM records and a master PM record can be made. 

Answer: D

  

QUESTION NO: 45 

Which statement describes the function of the Select Items for Return button?

A. to return excess inventory items to another storeroom bin 
B. to return inventory items to a storeroom found in the workshop 
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C. to return issued but unused inventory items to another storeroom 
D. to return issued but unused inventory items to the original storeroom 

Answer: D

  

QUESTION NO: 46 

Which fields are required when defining a Continuous meter?

A. Meter Type and Domain 
B. Domain and Unit of Measure  
C. Meter Type and Reading Type 
D. Reading Type and Unit of Measure 

Answer: C

  

QUESTION NO: 47 

Which IBM Maximo Asset Management V7.5 application builds and displays failure hierarchies?

A. Failure Class 
B. Failure Codes 
C. Failure Reporting 
D. Failure Structures 

Answer: B

  

QUESTION NO: 48 

In the Work Order Information section of the Preventive Maintenance application which field is
mandatory?

A. Priority 
B. Location 
C. Workgroup 
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D. Work Order Status  

Answer: D

  

QUESTION NO: 49 

Which two items are required to approve a purchase contract? (Choose two.)

A. A vendor 
B. An authorized site 
C. A total cost greater than zero 
D. At least one contract line item 
E. Association to at least one commodity code 

Answer: A,B

  

QUESTION NO: 50 

A shipment must be created to move items between storerooms using the Inventory Usage
application. What Usage Type can the Inventory Usage record be in order to perform shipping?

A. ISSUE  
B. RETURN  
C. SHIPPING 
D. TRANSFER 

Answer: D

  

QUESTION NO: 51 

What is a valid report option in the Labor Reporting application for external contractors or internal
employees?

A. Reporting labor by site 
B. Reporting labor by contract 
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C. Reporting labor by work order 
D. Reporting labor by organization 

Answer: C

  

QUESTION NO: 52 

Where are Work Orders created?

A. Item application 
B. Work Entry application 
C. Group Work application 
D. Work Order Tracking application 

Answer: D

  

QUESTION NO: 53 

Which statement is true about installing IBM Maximo Asset Management V7.5?

A. The default database name is customizable. 
B. The default database instance name is not customizable. 
C. The default database buffer pool name MAXBUFPOOL is customizable. 
D. The default database data table space name MAXINDEX is not customizable. 

Answer: A

  

QUESTION NO: 54 

In addition to the Work Order Tracking application, which other application allows a user to plan
labor or crafts?

A. Labor application 
B. Safety Plan application 
C. Quick Reporting application 
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D. Activities and Tasks application 

Answer: D

  

QUESTION NO: 55 

Where is the Attached Documents location defined when using IBM HTTP Server?

A. web.xml file 
B. httpd.conf file 
C. httpapp.xml file 
D. document.conf file 

Answer: B

  

QUESTION NO: 56 

How is a cron task instance run?

A. Define a schedule and set to Active 
B. Set to Active and turn Admin mode on 
C. Define a schedule and set the parameters 
D. Turn Admin mode on and define a schedule 

Answer: A

  

QUESTION NO: 57 

When a Service Level Agreement (SLA) is created, two different types of calendars can be used:
an Applies To calendar or a Calculation calendar. Which statement is valid?

A. The Applies To calendar is used when SLAs are applied to other SLAs. 
B. The Applies To calendar specifies the business hours for a particular shift for an organization. 
C. When both calendar types are left blank, time and shifts are both used as record matching
criteria. 
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D. The Calculation calendar determines valid values based on a defined SQL query specified by
the creator. 

Answer: B

  

QUESTION NO: 58 

Which statement is true regarding the relationship between escalations and actions?

A. Action type must be accessible from ALL. 
B. Actions in a group must be associated to a sequence. 
C. Actions must be associated to an escalation through action groups. 
D. At least one action and notification must be associated to an escalation point. 

Answer: C

  

QUESTION NO: 59 

What are three standard reported priority values for a service request in the Service Request
application? (Choose three.)

A. Low 
B. High 
C. Urgent 
D. Normal 
E. Delayed 
F. Planning 

Answer: A,B,C

  

QUESTION NO: 60 

Which three are valid Request for Quotation statuses? (Choose three.)

A. APPR  
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B. COMP  
C. INPRG  
D. DRAFT  
E. READY  
F. WAPPR 

Answer: B,C,E

  

QUESTION NO: 61 

An invoice was approved but then a mistake is found and must be corrected. How is this done?

A. Change status to EDIT, correct the invoice, and approve it 
B. Change status to WAPPR, correct the invoice, and approve it 
C. Change status to REVISED and create a new invoice with the correct details 
D. Change status to DUPLICATE and correct a new invoice with the correct details 

Answer: C

  

QUESTION NO: 62 

When authorizing access to labor information in the Security Groups application, which statement
is correct?

A. Authorize Group for Labor in Their Same Site 
B. Authorize Group for Labor in Their Same Crew 
C. Authorize Group for Labor in Their Same Organization 
D. Authorize Group for Labor in Their Same Service Provider Group 

Answer: B

  

QUESTION NO: 63 

CBA Corporation wants to create a new application. This application should have four tabs,
including List and Main. Which application type should be used?
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A. Smart application 
B. Power application 
C. Multi Tab application  
D. Single Page application 

Answer: B

  

QUESTION NO: 64 

Which statement describes how an inventory backorder reservation type is set?

A. Run the reorder process and enable the Backorder check box 
B. Enable Backorder as a reservation type with the Work Order - Materials sub-tab 
C. Enable Disallow Negative Available Balance in Organizations > Inventory Options > Inventory
Defaults 
D. Select an item with a current balance less than the quantity ordered in the Work Order-
Materials sub-tab 

Answer: C

  

QUESTION NO: 65 

What is a Work Order?

A. Request for route stop 
B. Request for inventory reorder 
C. Request for work to be performed 
D. Request for user access to application 

Answer: C

  

QUESTION NO: 66 

After fully receiving a shipment, it is discovered that the item or tool is damaged and must be sent
back. How is it recorded that the good(s) have been returned in the Shipment Receiving
application?
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A. Find the shipment receipt, select New Row, enter the quantity, item, and then select
SHIPRETURN for the Transaction Type 
B. Find the shipment receipt, select New Row, enter the quantity, item, and then select
SHIPDAMAGED for the Transaction Type 
C. Find the shipment receipt, select the button Select Damaged Items, select each item and
update the quantity to be returned, click OK 
D. Find the shipment receipt, select the button Select Items for Return, select each item and
update the quantity to be returned, click OK 

Answer: D

  

QUESTION NO: 67 

Which statement best describes work order flow control?

A. It is a classification category of a job plan intended to be used to facilitate processing of service
requests to work orders. 
B. Job plans use a flow control algorithm to define the proper processing of job plans for
preventive maintenance records that utilize job plan sequencing. 
C. It can be defined in a job plan and is a set of business rules built into the work management
applications that allow status changes to be processed automatically. 
D. It is a component of workflow used to route work orders through a structured planning, approval
and scheduling process, taking into account resource availability. 

Answer: C

  

QUESTION NO: 68 

A customer's process requires that a manager is notified by e-mail for any IT-related purchases.
Which object is required to generate the proper notification?

A. Role 
B. Escalation 
C. Notification Action 
D. Communication Form 

Answer: B
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QUESTION NO: 69 

What action is required in order to activate a workflow process in an application?

A. Enable the process 
B. Initiate the process 
C. Approve the process 
D. Create a process revision 

Answer: A

  

QUESTION NO: 70 

Which two utilities verify a successful IBM Maximo Asset Management V7.5 installation? (Choose
two.)

A. solutionInstaller 
B. installValidation 
C. installVerification 
D. solutionValidation 
E. installHealthCheck 

Answer: A,B

  

QUESTION NO: 71 

When using the Asset Templates application to update existing assets, what prevents data from
being overwritten when applying the template?

A. Leave the fields blank 
B. Modify the Site options 
C. Modify the Organization options 
D. Check the Update Existing fields checkbox 

Answer: A
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Topic 2, Volume B

QUESTION NO: 72 

What is a preventive maintenance (PM) record?

A. Template for labor assignment 
B. Template for preventive workflow process 
C. Template for maintenance security group definition 
D. Template for scheduled preventive maintenance work 

Answer: D

Create preventive maintenance plans for work assets and locations in the

Preventive Maintenance application. 

You can use the Preventive Maintenance application to accomplish the following tasks: 

QUESTION NO: 73 

When creating new Business Intelligence and Reporting Tool (BIRT) reports for use by the various
IBM Maximo Asset Management applications, which step correctly describes a part of the process
to add a new report?

A. Before design files are imported, any associated library files must be imported  
B. Using the system configuration option, choose the report designer files to import 
C. Using the BIRT Report Designer Workstation, select the menu item to import the new report 
D. Before design files are imported, the location files that specify the location of the images and
report files must be populated 

Answer: A

  

QUESTION NO: 74 

Where are labor option settings defined?

A. Sites application 
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B. Labor application 
C. Person application 
D. Organizations application 

Answer: D

  

QUESTION NO: 75 

How are IBM Maximo Asset Management V7.5 (Maximo) properties changed while Maximo is
running?

A. Live Refresh action item in the Logging Properties application 
B. Live Refresh action item in the System Properties application  
C. Apply Settings action item in the System Properties application  
D. Apply Settings action item in the Logging Properties application 

Answer: B

  

QUESTION NO: 76 

CBA Corporation has deployed IBM Maximo Asset Management V7.5 (Maximo) to manage
company assets. They also want to customize the Assets application and create a new field called
Category. This new field should allow the user to select a value from a predefined value list. The
Domain is created, the attribute and domain are already set in the Database Configuration but in
the Assets application, the Category field still does not show the Detail button beside the Category
field.

What is the probable cause for the Detail button not being visible?

A. Maximo has not been restarted. 
B. The maximo.ear file has not been rebuilt and redeployed. 
C. The asset.jsp file needs to be modified to include the Lookup value. 
D. In the Assets application, the Lookup value is not defined in the Category field. 

Answer: D
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QUESTION NO: 77 

Which statement is true regarding job plan editing?

A. Job plans with a status of DRAFT or PNDREV may be edited. 
B. Job plans can never be edited once they have been revised (revision number > 0). 
C. To edit a job plan, use the select action command to Revise Job Plan. This action cancels the
initial job plan, creating an editable copy in the REVISED status. 
D. To designate a job plan for a different organization or site, use the select action command to
Revise Job Plan and then change the organization or site identifier. 

Answer: A

  

QUESTION NO: 78 

For what purpose is the Activities and Tasks application used?

A. To plan, review, and manage activities and tasks 
B. To create and manage job plans, activities, and tasks 
C. To plan and manage preventive maintenance, activities, and tasks 
D. To create, plan, and manage preventive maintenance, activities, and tasks 

Answer: A

  

QUESTION NO: 79 

A user can review the meter readings history from the Assets application and which other
application?

A. Meters 
B. Meter Groups 
C. Condition Monitoring 
D. Activities and Tasks 

Answer: C
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QUESTION NO: 80 

How can a document be included in an e-mail sent from a communication template?

A. On the Attachment Folders tab, check the Include box 
B. On the Create Communication dialog, select attachments to send 
C. On the Linked Documents tab, check the Send with Communication box 
D. On the Communication Template tab, click Attachments and select a document 

Answer: D

  

QUESTION NO: 81 

What are two valid options for route stops? (Choose two.)

A. Meters 
B. Assets 
C. Locations 
D. Configuration Item Records 
E. Condition Monitoring Points 

Answer: B,C

  

QUESTION NO: 82 

How is Assignment Manager used?

A. To assign PMs to a site 
B. To assign users to security groups 
C. To dispatch assignments from a workflow process 
D. To dispatch labor and schedule work for the organization 

Answer: D

  

QUESTION NO: 83 
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A number of items or tools have arrived at a company's receiving dock from another site and
include a shipping number. Which application is used to acknowledge and officially receive these
items?

A. Receipts 
B. Receiving 
C. Shipment Receiving 
D. Goods Acknowledgement 

Answer: C

  

QUESTION NO: 84 

Which statement is true regarding the escalation cron task?

A. It must have an execution entry. 
B. It runs all active escalations every 30 seconds. 
C. It runs all active escalation definitions at a set schedule 
D. It uses the SQL Expression Builder to retrieve records from the database 

Answer: C

  

QUESTION NO: 85 

A job plan is used throughout the organization and has six tasks except for one site (site A) that
has an additional task. What is the best approach to accomplish this requirement?

A. Create a job plan with the six tasks that apply to both sites. Create a nested job plan that
references the unique task, designate it for site A and associate it with the first task. 
B. For the job plan or tasks, do not define an organization or site. When the work order for a site
other than site A is created, delete the task which does not apply from the work order. 
C. For the job plan or the six tasks that apply to both sites, do not define an organization or site.
For the additional task that is specific for site A, designate the site ID for that task as site A. 
D. Two job plans are needed: one that is designated as site A at the job plan level and has the
seven appropriate job tasks for that site, and one without a defined site for the six job tasks
appropriate for the remaining sites. 

Answer: C
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QUESTION NO: 86 

In which application is the default stock category set?

A. Inventory 
B. Item Master 
C. Organizations 
D. Inventory Usage 

Answer: C

  

QUESTION NO: 87 

How are reorder items designated in IBM Maximo Asset Management V7.5?

A. The item reorder flag is set to Yes in Inventory. 
B. The item reorder flag is set to Yes in the Item Master. 
C. The item stock category is set to Stocked in Inventory. 
D. The item stock category is set to Stocked in the Item Master. 

Answer: A

  

QUESTION NO: 88 

Which statement is true regarding reversing an invoice?

A. The original invoice can be replaced by reversing it. 
B. An invoice can be reversed by creating a return receipt.  
C. An invoice can be reversed creating a return transaction. 
D. A three way match invoice can be reversed creating a return transaction. 

Answer: A
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QUESTION NO: 89 

Which statement is true about a master preventive maintenance (PM) record?

A. A master PM record does not generate work orders. 
B. Associated PM records cannot be created from master PM records. 
C. A master PM record generates work orders like any other PM records. 
D. Associations between existing PM records and a master PM record cannot be made 

Answer: A

  

QUESTION NO: 90 

To fully utilize a safety plan, what is the proper sequence to create the necessary records?

A. Create the lock outs, create the asset, create the work order, and then create the safety plan 
B. Create the hazard, create the precaution, create the safety plan, and then create the work order 
C. Create the hazardous material, create the safety plan, create the precautions, and then create
the lock outs 
D. Create the asset, create the hazards for the asset, create the safety plan, create the tag outs,
and then create the work order  

Answer: B

  

QUESTION NO: 91 

When security groups involve application access rights, which statement is correct when
configuring IBM Maximo Asset Management V7.5?

A. The amount of viewable data is independent of the security settings of the application. It is
controlled by user privileges. 
B. Any changes that are made within a site-level application are limited to the sites the user is
currently authorized to access. 
C. When a user has access to a system-level application, any changes that are made in that
application have a system-wide impact. 
D. When a change is made in an organizational-level application, the change applies to only the
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sites in the organization the user is currently authorized to access. 

Answer: C

  

QUESTION NO: 92 

A failure class can be associated to which two Maximo entities? (Choose two.)

A. Meters 
B. Assets 
C. Routes 
D. Locations 
E. Preventive Maintenance 

Answer: B,D

  

QUESTION NO: 93 

When utilizing a route, the Child Work Orders option is specified. What logic does IBM Maximo
Asset Management V7.5 use to assign a description to the generated child work orders?

A. If the route record has a description, it becomes the child work order description. 
B. If the route stop has no description and it refers to an asset, the work order description is the
asset description. 
C. If the route stop references a job plan, the work order description is a concatenation of the job
plan identifier and the job plan description. 
D. If the route stop has no description and it refers to a location, the work order description is a
concatenation of the location identifier and location description 

Answer: D

  

QUESTION NO: 94 

What does the <instaii  homeVCTG_DE\acsi\bin\iistiu command do?
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